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                    Capítulo 1:
                
                Introdução
            

            
    
            
            
                
                    
                        
                            1.1
                        
                        O projeto e as tecnologias
                    

                    
                        Durante este livro, trabalharemos no projeto de uma livraria. A princípio, vamos criar uma listagem de produtos com Java FX e ao decorrer dos capítulos incrementaremos suas funcionalidades, passando pelas APIs de IO, JDBC, Threads e muito mais. Além disso, a todo o momento discutiremos sobre boas práticas da orientação a objetos e design patterns. 

                        Ao final, o projeto deve ficar parecido com:

                        [image: Aparência final do projeto deste livro]
Fig. 1.1: Aparência final do projeto deste livro




                        Essa listagem de livros é carregada de um banco de dados MySQL, utilizando a API de JDBC. O build e gerenciamento de dependências é totalmente automatizado, com uso do tão popular Maven. A ação de exportar os livros é feita em uma Thread diferente, que roda em paralelo com a Thread principal da aplicação.

                        Nosso código já usará a sintaxe e recursos do Java 8, como as famosas expressões lambdas. Mas não se preocupe, você não precisa conhecer Java 8 ou nenhuma outra tecnologia além de Java puro para continuar, cada novidade será muito bem detalhada. Pronto para começar?

                    
                    

                

                
                    
                        
                            1.2
                        
                        Instalando e configurando o Eclipse
                    

                    
                        Para começar, você precisará do Eclipse ou qualquer outra IDE de sua preferência. Utilizarei o Eclipse em meus exemplos, devido ao ganho de produtividade (que será mencionado em alguns pontos do livro), além de sua popularidade no mercado e instituições de ensino. Se quiser, você pode fazer o download do Eclipse em:

                        https://www.eclipse.org/downloads/

                        Para utilizar o Java FX no Eclipse, você também precisará do e(fx)clipse, que pode ser baixado pelo seguinte link, no qual você também encontrará um passo a passo para instalá-lo.

                        http://www.eclipse.org/efxclipse/install.html

                        

Algumas outras opções



                        Além do Eclipse, existem diversas outras IDEs que podem ser utilizadas no desenvolvimento desse projeto. Netbeans e Intellij IDEA são algumas delas. O Netbeans já vem com suporte ao Java FX, sendo assim você não precisará instalar nada. Você pode ler mais sobre ele e fazer o download em:

                        https://netbeans.org/

                        Segundo as pesquisas mais recentes, logo depois do Eclipse, o Intellij IDEA é a IDE mais utilizada pelos desenvolvedores Java. Mas há uma questão: ela é paga. Você pode baixar uma versão Community Edition (gratuita), mas ela deixa um pouco a desejar. Se quiser experimentar a versão completa, tem como opção baixar um trial por 30 dias. 

                        https://www.jetbrains.com/idea/

                        Apesar de utilizamos Eclipse nos exemplos desse livro, você pode usar a IDE de sua preferência. Fique à vontade em sua escolha.

                    
                    

                

                
                    
                        
                            1.3
                        
                        Download dos arquivos pro projeto
                    

                    
                        No link a seguir, você encontrará todos os arquivos necessários para acompanhar ativamente os códigos desse livro. Ele inclui a base do projeto, os jars necessários para você fazer os exercícios, um arquivo de dump com alguns livros já cadastrados no banco, entre outros.

                        http://goo.gl/CfzTLB

                        

	




Desbravando a Orientação a Objetos

Se você já leu meu livro Desbravando a Orientação a Objetos, perceberá que esta é uma evolução do projeto que desenvolvemos por lá. Você pode continuar com seu próprio projeto, ou baixar o projeto já pronto se preferir.

[image: Desbravando Java e Orientação a Objetos]
Fig. 1.1: Desbravando Java e Orientação a Objetos



http://www.casadocodigo.com.br/products/livro-orientacao-objetos-java



	





                    
                    

                

                
                    
                        
                            1.4
                        
                        Acesse o código desse livro
                    

                    
                        Todos os exemplos desse livro e também seu código final, em Java 7 e 8, podem ser encontrados no seguinte repositório:

                        	https://github.com/Turini/livro-java


                        Não deixe de escrever todos os códigos e exercitá-los durante os capítulos. Assim você pode tirar um proveito maior do conteúdo. Vá além do que é aqui sugerido, escreva novos testes, novos layouts e não deixe de compartilhar sua experiência conosco.

                    
                    

                

                
                    
                        
                            1.5
                        
                        Aproveitando ao máximo o conteúdo
                    

                    
                        Além de colocar todos os exemplos em prática, não deixe de consultar também a documentação de cada API e biblioteca que vamos utilizar. Eu sempre disponibilizo alguns links que podem ser úteis quando um novo assunto é introduzido. 

                        Como nosso foco principal é Java, tenha sempre por perto a documentação da linguagem:

                        http://docs.oracle.com/javase/8/docs/api/

                        Se estiver devidamente configurado, você pode ver a documentação das classes e métodos pelo próprio Eclipse. Sempre que estou conhecendo uma nova API, costumo usar o recurso de autocomplete (atalho Control + space) e navegar pelos seus métodos. 

                        Veja que, quando paramos em um método específico, um box com sua documentação é exibido:

                        [image: Explorando a API do Java pelo Eclipse]
Fig. 1.2: Explorando a API do Java pelo Eclipse




                    
                    

                

                
                    
                        
                            1.6
                        
                        Tirando suas dúvidas
                    

                    
                        Ficou com alguma dúvida durante o livro? Mande um e-mail! Uma lista de discussões foi criada exclusivamente para facilitar seu contato comigo e com os demais leitores deste livro. Você pode e deve compartilhar suas dúvidas, ideias, sugestões e criticas. Todas serão muito bem-vindas.

                        https://groups.google.com/group/livro-java

                        Outro recurso que você pode utilizar para esclarecer suas dúvidas e participar ativamente na comunidade Java é o fórum do GUJ. Lá você não só pode perguntar, mas também responder, editar, comentar e assistir a diversas discussões sobre o universo da programação. 

                        http://www.guj.com.br/

                    
                    

                

        

                
                        
        
        

            
                
                    Capítulo 2:
                
                Java FX
            

            
    
            
            
                
                    
                        
                            2.1
                        
                        Nossa primeira App em Java FX
                    

                    
                        Neste capítulo, criaremos uma tela simples usando Java FX, que servirá como base para integrarmos algumas das outras APIs que veremos no decorrer do livro. Apesar de nosso foco não ser a interface gráfica em si, escolhemos o Java FX por ser uma alternativa muito interessante e mais moderna do que o swing, além de ser bastante elegante. O Java FX já vem incluso no JDK e JRE.

                        

Criando o projeto no Eclipse



                        Agora que já configuramos nosso Eclipse para escrever aplicações em Java FX, podemos criar um novo projeto. Para fazer isso, basta clicar em File > New > Other... e escolher a opção Java FX Project. Podemos chamar o projeto de livraria-fx, depois clicar em finish para concluir.

                        Se você estiver utilizando uma versão atual do Eclipse (o que é bastante recomendado), já deverá aparecer uma estrutura padrão para sua aplicação, como na seguinte imagem:

                        [image: Estrutura inicial do projeto no Eclipse]
Fig. 2.1: Estrutura inicial do projeto no Eclipse




                        Note que dentro do src, temos uma pacote chamado application com a classe Main.java e o arquivo application.css. Veremos mais detalhes sobre esse arquivo .css mais à frente, por enquanto vamos focar no código Java. A classe Main já deve ter sido criada com o seguinte código:

                         1 public class Main extends Application {
 2 
 3   @Override
 4   public void start(Stage primaryStage) {
 5     try {
 6       BorderPane root = new BorderPane();
 7       Scene scene = new Scene(root,400,400);
 8 
 9       scene.getStylesheets()
10         .add(getClass().getResource("application.css")
11         .toExternalForm());
12 
13       primaryStage.setScene(scene);
14       primaryStage.show();
15     } catch(Exception e) {
16       e.printStackTrace();
17     }
18   }
19   
20   public static void main(String[] args) {
21     launch(args);
22   }
23 }




                        Não se preocupe caso em seu Eclipse, ou qualquer outra IDE de sua preferência, essa classe não tenha sido criada. Você pode criá-la facilmente, mas aproveite e mantenha apenas o código que importa agora nesse começo. Vamos apagar esse try catch e linhas que criam a classe Scene e aplicam o estilo css. Por agora só precisamos do seguinte código:

                         1 public class Main extends Application {
 2   
 3   @Override
 4   public void start(Stage primaryStage) {
 5     primaryStage.setTitle("Sistema da livraria com Java FX");
 6     primaryStage.show();
 7   }
 8   
 9   public static void main(String[] args) {
10     launch(args);
11   }
12 
13 }




                        Note que já adicionei um titulo que não existia no arquivo Java, faça o mesmo e execute essa classe para ver o primeiro resultado. Se tudo correu bem, uma tela cinza com o título Sistema da livraria com Java FX deve aparecer:

                        [image: Primeira tela em Java FX]
Fig. 2.2: Primeira tela em Java FX




                        

	




Executando código no Eclipse

Caso não esteja familiarizado com o Eclipse, você pode executar seu código de diversas maneiras. Uma delas é clicando com o botão direito na classe, selecionando Run As... e depois Java Application. Outra alternativa bem prática é utilizando o atalho Control + F11.



	





                        Excelente, já temos algum resultado. Mas antes de seguir precisamos entender um pouco mais sobre a anatomia desse nosso primeiro código. 

                        Podemos começar pela classe javafx.application.Application. A regra é simples, a classe principal de nossas aplicações em Java FX precisa herdar de Application e consequentemente sobrescrever seu único método abstrato, chamado start. Esse é o ponto de partida de toda aplicação que em Java FX.

                        Vale lembrar que como esse método é abstrato, somos obrigados a sobrescrevê-lo. Portanto, caso você não lembre disso, o compilador certamente lhe lembrará com um erro. Além disso, perceba que esse método recebe um objeto do tipo Stage como parâmetro, que é o container principal da aplicação.

                        Por fim, note também que temos um método main. Nele, invocamos um outro método chamado launch, também presente na classe Application. Ele é o responsável por iniciar a aplicação.

                    
                    

                

                
                    
                        
                            2.2
                        
                        Configurando a livraria-base
                    

                    
                        Agora que já sabemos um pouco mais sobre esse código inicial, vamos começar a implementar a nossa listagem de Produtos. Para isso, precisaremos da interface Produto e de suas implementações, presentes no arquivo que você deve ter baixado no capítulo anterior. Não se preocupe se você ainda não baixou, você pode fazer isso agora pelo seguinte link:

                        http://goo.gl/CfzTLB

                        Após concluir o download, você precisará importar o projeto no Eclipse. Primeiro, extraia o conteúdo do ZIP que você baixou para alguma pasta de sua preferência. Agora, pelo Eclipse, clique no menu File, Import... e depois em Existing Projects into Workspace.

                        [image: Importando projeto pelo Eclipse.]
Fig. 2.3: Importando projeto pelo Eclipse.




                        Selecione o diretório (em Browse...) onde você colocou o projeto livraria-base, que estava dentro do ZIP, e logo depois clique em Finish.

                        [image: Concluindo import do projeto base.]
Fig. 2.4: Concluindo import do projeto base.




                        Queremos agora vincular os dois projetos. Por enquanto, faremos isso pelo próprio Eclipse, clicando com o botão direito no projeto livraria-fx, opção Build Path e depois Configure Build Path....

                        [image: Build Path > Configure Build Path...]
Fig. 2.5: Build Path > Configure Build Path...




                        Vá à aba Projects, clique em Add, escolha o projeto livraria-base, que acabamos de importar. Depois basta clicar em Ok.

                        [image: Adicionando projeto no build path.]
Fig. 2.6: Adicionando projeto no build path.




                    
                    

                

                
                    
                        
                            2.3
                        
                        Preparando nosso cenário
                    

                    
                        Antes de criar uma tabela, precisamos criar um cenário, onde ficará todo o conteúdo dessa nossa tela. Uma tela do Java FX sempre é composta por um container principal (Stage) e também por um cenário, representado pela classe Scene. Repare em sua estrutura:

                        1 Scene scene = new Scene(root, largura, altura)




                        Os parâmetros largura e altura representam bem seu significado, não é? Definimos nele o tamanho do nosso cenário, da tela da nossa aplicação. Já esse root nada mais é do que um auxiliar, que ajuda no processo de layout, como ao adicionar ou remover elementos. 

                        O tipo do parâmetro root é javafx.scene.Parent, que é uma classe abstrata. De acordo com nossa necessidade, escolhemos uma de suas implementações. Como a tela será composta por 2 elementos (um label e uma tabela), podemos usar um Group.

                        

	




Outras implementações

Além do Group, temos como opções diretamente as classes Control, Region e WebView. Além disso, cada uma dessas tem diversas outras subclasses. São várias possibilidades! Uma opção bastante usada é a GridPane, do pacote javafx.scene.layout. Ela é filha de Pane, que é filha de Region que, finalmente, é filha de Parent. Ufa!

[image: Hierarquia da classe javafx.scene.layout.GridPane]
Fig. 2.1: Hierarquia da classe javafx.scene.layout.GridPane



Você pode conhecer um pouco mais sobre essa e outras implementações em:

https://docs.oracle.com/javafx/2/api/javafx/scene/Parent.html

Veremos diversas delas durante o livro.



	





                        O código do nosso método start deve ficar parecido com:

                        1 public void start(Stage primaryStage) {
2   Group group = new Group();
3   Scene scene = new Scene(group, 690, 510);
4   primaryStage.setScene(scene);
5   primaryStage.setTitle("Sistema da livraria com Java FX");
6   primaryStage.show();
7 }




                        Perceba que estamos chamando o método setScene, vinculando o cenário com o container principal. Quer ver o resultado? Não deixe de executar o código a cada evolução. Agora a tela estará maior e com um fundo branco, padrão do cenário. 

                        O próximo passo será colocar um texto na tela, indicando que essa será a nossa listagem de produtos. Faremos isso com a auxilio da classe Label, do pacote javafx.scene.control.

                        1 Label label = new Label("Listagem de Livros");




                        Podemos agora utilizar a classe Group, que está vinculada ao nosso cenário, para adicionar esse novo elemento na página. Para fazer isso, basta chamar seu método getChildren e adicionar todos os elementos necessários, que neste caso será apenas o label:

                        1 group.getChildren().addAll(label);




                        O código completo do método start deverá ficar assim:

                         1 public void start(Stage primaryStage) {
 2 
 3   Group group = new Group();
 4   Scene scene = new Scene(group, 690, 510);
 5 
 6   Label label = new Label("Listagem de Livros");
 7 
 8     group.getChildren().addAll(label);
 9   primaryStage.setScene(scene);
10   primaryStage.setTitle("Sistema da livraria com Java FX");
11   primaryStage.show();
12 }




                        Ao rodar esse código, teremos a saída esperada, mas o texto está muito pequeno e grudado nas margens da tela!

                        [image: Listagem com o label desalinhado.]
Fig. 2.7: Listagem com o label desalinhado.




                        Para melhorar um pouco a aparência desse label, podemos mudar sua fonte e também adicionar um padding. Para isso, vamos utilizar os métodos setFont e setPadding, como a seguir:

                        1 Label label = new Label("Listagem de Livros");
2 
3 label.setFont(Font
4   .font("Lucida Grande", FontPosture.REGULAR, 30));
5 
6 label.setPadding(new Insets(20, 0, 10, 10));




                        O método estático font, da classe javafx.scene.text.Font, nos possibilita passar a família, tipo e tamanho da fonte que queremos aplicar em nosso texto. Existem outras sobrecargas desse método para aplicar apenas o tamanho, apenas família e assim por diante. Repare também que no setPadding estamos utilizando uma classe auxiliar para passar as medidas, a Insets.

                        Execute seu código mais uma vez para perceber o resultado:

                        [image: Listagem com label alinhada.]
Fig. 2.8: Listagem com label alinhada.




                        Um pouco melhor, não acha? Agora podemos partir para a tabela!

                    
                    

                

                
                    
                        
                            2.4
                        
                        Uma listagem de produtos
                    

                    
                        Nosso próximo passo será criar uma tabela para exibir nossa lista de produtos. Antes de focar na tabela, vamos criar uma nova classe no pacote repositorio, que será responsável por retornar a lista de produtos que deverá ser exibida. Podemos chamá-la de RepositorioDeProdutos:

                         1 package repositorio;
 2 
 3 public class RepositorioDeProdutos {
 4 
 5   public ObservableList<Produto> lista() {
 6     
 7     Autor autor = new Autor();
 8     autor.setNome("Rodrigo Turini");
 9     autor.setEmail("rodrigo.turini@caelum.com.br");
10     autor.setCpf("123.456.789.10");
11     
12     Livro livro = new LivroFisico(autor);
13     livro.setNome("Java 8 Prático");
14     livro.setDescricao("Novos recursos da linguagem");
15     livro.setValor(59.90);
16     livro.setIsbn("978-85-66250-46-6");
17 
18     Livro maisUmlivro = new LivroFisico(autor);
19     maisUmlivro.setNome("Desbravando a O.O.");
20     maisUmlivro.setDescricao("Livro de Java e O.O");
21     maisUmlivro.setValor(59.90);
22     maisUmlivro.setIsbn("321-54-67890-11-2");
23     
24     Autor outroAutor = new Autor();
25     outroAutor.setNome("Paulo Silveira");
26     outroAutor.setEmail("paulo.silveira@caelum.com.br");
27     outroAutor.setCpf("123.456.789.10");
28         
29     Livro outroLivro = new LivroFisico(outroAutor);
30     outroLivro.setNome("Lógica de Programação");
31     outroLivro.setDescricao("Crie seus primeiros programas");
32     outroLivro.setValor(59.90);
33     outroLivro.setIsbn("978-85-66250-22-0");
34     
35     return FXCollections
36       .observableArrayList(livro, maisUmlivro, outroLivro);
37   }
38 
39 }




                        Por enquanto, estamos criando os livros e autores manualmente, mas muito em breve faremos isso de uma forma bem mais interessante. Você já deve ter notado que o tipo de retorno dessa lista é um tanto diferente daquilo com que estamos acostumados, ela retorna uma ObservableList<Produto>. Esse é o tipo de lista que a tabela do Java FX espera receber. Criá-la é bem simples com o apoio da factory FXCollections, do pacote javafx.collections:

                        1 ObservableList lista = 
2   FXCollections.observableArrayList(...);




                        Agora que já temos uma lista, podemos voltar para a classe Main e criar um novo elemento em nosso cenário (Scene), uma tabela. Para fazer isso, utilizaremos a classe TableView, como a seguir:

                        1 ObservableList<Produto> produtos = 
2   new RepositorioDeProdutos().lista();
3 
4 TableView tableView = new TableView<>(produtos);




                        Já estamos passando a lista de produtos do RepositorioDeProdutos como argumento em seu construtor. Nesse momento o código de nosso método start está assim:

                         1 public void start(Stage primaryStage) {
 2   Group group = new Group();
 3   Scene scene = new Scene(group, 690, 510);
 4 
 5   ObservableList<Produto> produtos = 
 6     new RepositorioDeProdutos().lista();
 7   
 8   TableView tableView = new TableView<>(produtos);
 9   
10   Label label = new Label("Listagem de Livros");
11 
12   label.setFont(Font
13     .font("Lucida Grande", FontPosture.REGULAR, 30));
14   
15   label.setPadding(new Insets(20, 0, 10, 10));
16     
17     group.getChildren().addAll(label);
18   
19   primaryStage.setScene(scene);
20   primaryStage.setTitle("Sistema da livraria com Java FX");
21   primaryStage.show();
22 }




                        Podemos agora criar as colunas de nossa tabela. Basta criar uma instância do tipo TableColumn, recebendo o nome da coluna como parâmetro:

                        1 TableColumn nomeColumn = new TableColumn("Nome");




                        Além disso, para cada coluna precisamos definir sua fonte de dados, ou seja, qual propriedade da classe Produto deve ser exibida nessa determinada coluna. Para isso, chamamos seu método setCellValueFactory, passando um novo PropertyValueFactory como parâmetro:

                        1 TableColumn nomeColumn = new TableColumn("Nome");
2 
3 nomeColumn.setCellValueFactory(
4   new PropertyValueFactory("nome"));




                        Opcionalmente, você pode definir um tamanho mínimo e máximo para essa coluna, utilizando seus métodos setMinWidth e setMaxWidth. Um exemplo seria:

                        1 nomeColumn.setMinWidth(180);




                        Vamos criar uma coluna para cada um dos quatro atributos principais de nossos Produtos, seu nome, descrição, valor e ISBN (que é seu código único). 

                        Ao final, seu código deve ficar assim:
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